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Alternative Text and Images  
Alternative text also known as “alt text” is a brief 8 to 120-character description 

describing the elements of the image or what the image is conveying. Screen readers 

rely on alternative text to describe the image to the reader. In situations where the 

image is not available to the reader, perhaps because they have turned off images in 

their web browser or are using a screen reader due to a visual impairment, the 

alternative text ensures that no information or functionality is lost. The content creator is 

the best person to determine the alternative text for an image. Context is important 

when determining the alternative text; it will let you know if the alternative text is too 

descriptive or not descriptive enough. 

Note: Alternative Text can also be applied to Clip Art, Charts, Tables, Shapes*, 
SmartArt graphics, Groups**, Embedded objects, videos, and audio files. 

*Clip Art, Charts, Tables, and Shapes that do not contain text and are not in groups can 
have Alternative Text applied to them. 

**All objects in this list, except for shapes, should also have alt text when in groups. 
 

How to add alternative text: 

1. Select the desired object. 

2. Right click to bring up the Context Menu and select Edit Alt Text.  
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3. Type a brief but clear description of the object in the Alt Text box provided. 

4. Once done select the close button. 

Decorative Images 

Decorative images are images that present no important content to the context of your 

document. They are purely aesthetic. If you have images in your document that serve 

visual purposes and do not provide any information (clip art, banners, background 

images, etc.), mark them as decorative.   

How to mark images as decorative: 

1. Select the desired object. 

2. Right click to bring up the Context Menu and select Edit Alt Text.  

3. Select the “Mark as decorative” checkbox. 
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Best Practices for Alt Text 

• Avoid using phrases such as “image of” or “photo of” because screen readers 

already announce that it’s an image.  

• Avoid using images of text because assistive technology cannot convert the text 

within the images. 

• The “Alt Text” tool does not have spell check, please ensure that the alt text is 

spelled correctly. 

• Avoid using the “generate a description for me” feature because the alternative 

text may not always be accurate.  

• Decorative images that don’t convey any meaning don’t require alternative text 

and should either be tagged as an artifact on Adobe Acrobat or have a “Null” 

alternative text on Microsoft Word. Both methods ensure screen readers skip the 

decorative images. 

Lists 
Lists are used to format information sequentially without the use of characters such as 

plus signs or asterisks. Always use the Bullets or Numbering tools instead of other 

characters for listing information. For the purposes of this tutorial, we will use the 

Bullets tool. 

How to create a list: 

1. To create a list, first highlight the text you wish to format. 

2. Make sure you are within the Home tab. 

3. Select the Bullets tool pull-down for different list options. 

4. Select the desired bullet style.  
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Tables 
Follow these simple steps to properly create a table: 

1. Navigate to the Insert tab. 

2. Select the Table button. 

3. Choose the number of rows and columns for your table. 

4. After creating your table, type in the appropriate content for each row and 
column. 

Tips for Building Tables: 

• Have clear and understandable column or row headers (week, due date, grades, 

topic, etc.). 

• Assign header rows in the Table Style Options. 

• Avoid merging cells. 

• Avoid merging multiple tables. 

• Avoid low contrast cell colors. 

• Add alternative text to your tables (this process is the same as adding alternative 

text to images – right click then select “Format Shape” Example Below).  
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Tables: Good, Better, and Best 
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Hyperlinks 
Hyperlink text should provide a clear description of the link destination, rather than only 

providing the URL. There are many options when it comes to including a hyperlink in 

your document. You can insert and attach a hyperlink with an email, an external 

document, webpage, or even within the same document. 

Links must have a descriptive link text that describes the intent or purpose of the link. 

For example, avoid using “Click here” or “Read more.” Screen reader users often 

navigate through links to skim through the document; when they come across links 

descriptions like “Click here,” they will not understand the purpose or the link’s 

destination. Instead, include the webpage or document title as the link description. 

Figure 1 The picture above shows the don'ts for creating descriptive link text. The 
examples shown are “Click here,” “Read more,” and an entire URL with no link text. 

Figure 2 The picture above shows the do's for creating descriptive link text. The 
examples shown are “Student Financial Aid,” “Fall 2020 Registration Guide,” and 
“Accessible Instructional Materials (AIM) Center.” These are great examples of 
descriptive link because it demonstrates the purpose of the link. 
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Links must be visually different from regular text. Links are often identified by using 

underline and color. However, color shouldn’t be the only method to identify links and 

should be accompanied by an underline or italics. Both these methods will help increase 

the document’s readability by allowing the reader to identify links visually. 

Figure 3 In the example above, there are no visual indicators for links such as underline 
and color. Readers will not know that links are present within the paragraph. 

Figure 4 In this example above, the links appear visually different from regular text. The 
link text contains a combination of color and underline. The combination of these 
indicators will make the links apparent to visual readers. 

Inserting a hyperlink within a document 

This example will demonstrate how to insert a hyperlink for a document file or webpage 

that is located separately and outside of the document. 

1. Highlight the desired area. 

2. Navigate to the Insert tab. 

3. Select Hyperlink from the Links group. 
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4. In the Insert Hyperlink Window select the first option “Existing File or Web Page” 

located at the top of the pane. 

5. In the text to display field, overwrite the text that is by default present with a 

clear description that is easy to understand and identify. In this case, I used 

“BeachBoard Log-In Homepage.” 

6. In the Address field make sure that the complete URL is included and that the 

text corresponds with the correct URL address. 

7. Click OK when done. 
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Tip: It is in best practice to avoid using the complete URL website address because it 

can be cumbersome to listen to when using a screen reader, especially if it is a long 

URL address. 

Figure 5 The image above demonstrates what the document looks like after inserting a 
hyperlink using best practices.  The text will also change to blue to inform you that it is 
now a hyperlink. 

Color Contrast 
Colorblindness affects a significant number of people, most often as an inability to 

distinguish between red and green, or seeing red and green differently. When creating 

presentations, it’s important to choose elements that increase visual contrast so viewers 

who cannot rely on color distinction can still understand what they’re seeing.  

Color contrast should meet the minimum Level AA standard and maintain at least a 

color contrast ratio of 4.5:1. There are different accessibility software and programs, 

such as the WebAim Contrast Checker, to check for color accessibility. 

Here’s another example of “good” and “bad” contrast: 

https://webaim.org/resources/contrastchecker/
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Color to Convey Information  

Color should not be the only method to convey information. Readers that cannot 

perceive color will be unable to understand the context or representation of the color. 

Instead, in combination with color, use different objects such as shapes to differentiate 

between content. 

 

Figure 6 The image on the left shows the color version to demonstrate how readers 
perceive color will view the image. They will be able to find the number of orange 
triangles. The image on the right shows how people who cannot perceive color will view 
the image. They will be unable to find the number of orange triangles because they all 
appear the same. 

 

Figure 7 This image asks, "how many triangles are there?" This question does not rely 
on sensory characteristics such as color to understand the context of the question. 
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Color Contrast Best Practices 

• Avoid using light orange, red, and green in your template and text. 

• Use texture in graphs, instead of color, to highlight points of interest. 

• Circle to highlight information, rather than relying on color. 

• Keep the overall contrast in your presentation high. In other words, avoid using 

light colored text against light backgrounds, and dark colored text against dark 

backgrounds. 

• Colour Contrast Analyser is a free software that checks contrast accessibility for 

background and foreground colors using WCAG 2.1 standards. 

• Color Safe develops accessible color palettes.  

Fonts 
Believe it or not, even the fonts you use can affect whether your documents are 

accessible. With so many devices out on the market, more operating systems are being 

used between desktop, laptop, tablet, and cell phones than ever before. There are, 

however, fonts that are used mutually across all these platforms. Below is a list of 

accessible fonts that are found on Windows, Mac, Chrome, Linux, and various tablet 

and cellphone devices. 

List of Accessible Fonts: 

• Arial 

• Comic Sans MS 
• Courier New 

• Georgia 
• Times New Roman 

• Verdana 
 

Additional Information and Recommendations: 

• Try and keep your font size at least 12 points or larger 

• Avoid fonts downloaded from 3rd party websites 

• Arial and Times New Roman are the most common and will present very few 

problems in both print and web formats 

https://developer.paciellogroup.com/resources/contrastanalyser/
http://colorsafe.co/
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Unique Slide Titles 
Slide titles are used for navigation and selection by people who are not able to view the 

slide. To add visible titles to your slides, do the following: 

1. Click on the view tab. 

2. Click on the outline view icon. This will sequentially show your slides and give 

you the option to edit their titles. 

3. Select the slide you wish to title. It will most likely already be titled the same as 

your header text, but here you can freely edit it if you so choose. 

Reading Order 

In designing your PowerPoint, please ensure that the reading order of each slide is 

logical. People who cannot view the slide will hear slide text, shapes and content read 

back in a specific order. If you are using objects that are not part of the slide template, it 

is important to be sure that they will be read by a screen reader in the order that you 

intend them to be. 

To check the order in which your slide content will be read back, do the following: 

1. Navigate to the Home tab 

2. In the Drawing group, click Arrange and then choose Selection Pane. 
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3. Click on the Selection Pane option. This will list the objects on the slide. 

 

4. Objects will be read from the beginning with the bottom list item and ending with 

the top list item. 

5. Correct any out of order items using the Re-order arrows on the bottom of the 

pane. 

 

Accessibility Checker 
Just as the spelling checker tells you about possible spelling errors, Accessibility 

Checker in Word and PowerPoint tells you about possible accessibility issues in your 

Office file, so you can fix these issues to ensure someone with a disability can read and 

access your content. 
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Please note that the Accessibility Checker does not insure 100% accessibility. It is, 

however, a great tool for reviewing your document for errors you could possibly have 

missed. 

Follow these steps to utilize the Accessibility Checker: 

1. Navigate to the File tab. 

2. Under Info, select Check for Issues. 

3. In the drop-down list select Check Accessibility. 

 

  



 
Bob Murphy Access Center (BMAC) 

Accessible Instructional Materials (AIM) Center  

Accessible Instructional Materials (AIM) Center 

1250 Bellflower Blvd. AS-116 Long Beach, CA 90840 | 562.985.5401 | aimc@csulb.edu 

 

17 

4. The Accessibility Checker inspection results should then appear. Follow the 

checker and make the proposed changes to ensure accessibility of your 

document. 
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Accessibility Law 

Section 504 and the Americans with Disabilities Act of 1990 

Section 504 of the Rehabilitation Act of 1973 created and extended civil rights to people 

with disabilities. Section 504 has provided opportunities for children and adults with 

disabilities in education, employment, and various other settings. It allows for 

reasonable accommodations such as special study areas and assistance as necessary 

for each student in Federal agencies. Section 504 laws were then extended through the 

Americans with Disabilities Act of 1990 and the ADA Amendments Act of 2008 (ADAAA) 

which broadened the definition of “disability” to cover both individuals with physical and 

mental disabilities. 

Section 508 

This amendment to Section 504 and the Americans with Disabilities Act of 1990 was 

enacted in 1998 to eliminate barriers in information technology, to make available new 

opportunities for people with disabilities, and to encourage development of technologies 

that will help achieve these goals. The law applies to all Federal agencies when they 

develop, procure, maintain, or use electronic and information technology. Under Section 

508, agencies must give employees and members of the public with disabilities access 

to information that is comparable to the access available to others. California 

Government Code Section 11135-11139.8 requires all agencies that receive state 

money to comply with Section 508, and Executive Order Number 926 requires all CSU 

campuses to comply with Section 508. 

Accessible Technology Initiative (ATI) 

Effective on January 1st, 2005, Chancellor Charles B. Reed enacted CSU Executive 

Order 926, “The CSU Board of Trustees Policy on Disability Support and 

Accommodations.” The intent of the Accessible Technology Initiative is to make 

information technology resources and services accessible to all students, employees, 

and guests regardless of disability. CSULB is committed to the implementation of this 

initiative by maintaining consistent accessibility and promoting assistive technology to 

students, administrators, and faculty campus wide. 

This isn’t just the law 

This is your chance to assist this longstanding and respected institution of learning to 

better serve the public with only the greatest intentions of educational and moral 

outcomes for the success of others. 
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Recap and Accessibility Recommendations: 
• Remember that accessibility is more than just obeying laws; it’s your moral 

responsibility. 

• Assign a document title and set the language to your documents. 

• Assign alternative text to your images and tables. 

• Always use the “Bullets” or “Numbering” tools to make lists. 

• Use simple table structures. 

• Avoid using blank cells in tables. 

• Label hyperlinks with simple, but accurate descriptions. 

• Avoid using low contrast colors (pale or gray colors against white paper). 

• Try and keep your font size at least 12 points or larger 

• Label slides with unique titles. 

• Make sure the reading order flows properly. 

• Avoid using repeated blank [spacebar or return] characters (they will read as 

“blank” repeatedly by screen readers). 

• Avoid image watermarks (they may not be understood by people with visual or 

cognitive disabilities). 

• Ensure font size is sufficient. If your presentation will be viewed on a projector, 

font size may need to be even larger. 

• Use simple slide transitions when possible. Complex transitions can be confusing 

or distracting. 

• Run the accessibility checker to make sure you have made all appropriate 

changes to ensure accessibility is met. 
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Resources 
• Dos and Don’ts on Designing for Accessibility 

• Harvard University: Designing for Readability  

• Microsoft: Make Your PowerPoint Accessible to People with Disabilities 

• WebAim: Alternative Text 

• WebAim: Creating Accessible PowerPoints 

• WebAim: Links and Hypertext 

• CSULB: Document Accessibility 

• AIM Center: Accessibility Resources 

• Microsoft PowerPoint Training Videos 

• Americans with Disabilities Act Government Homepage 

• Section 504 Government Homepage 

• Section 508 Government Homepage 

• EO-926 / Accessible Technology Initiative Statement 

https://accessibility.blog.gov.uk/2016/09/02/dos-and-donts-on-designing-for-accessibility/
https://accessibility.huit.harvard.edu/design-readability
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us
https://webaim.org/techniques/alttext/
https://webaim.org/techniques/powerpoint/
https://webaim.org/techniques/hypertext/
https://www.csulb.edu/information-technology/accessible-technology/document-accessibility
https://web.csulb.edu/divisions/students/dss/aim/accessibility_resources.html
https://www.youtube.com/playlist?list=PLELSqs1L9DEAtJ5ZgC_PurK9CMjbjK6qu
https://www.ada.gov/
https://www2.ed.gov/about/offices/list/ocr/504faq.html
https://www.section508.gov/
https://www.calstate.edu/eo/EO-926.pdf
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